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2 Ruskin

Ruskin is the RBR software that manages your RBR loggers to provide all the data necessary to do your work. Ruskin 
provides a graphical user interface that makes using the loggers easy. You can use Ruskin to do the following:

Configure, schedule, and enable multiple loggers.
Download data after logging.
View data sets graphically.
Export data in various formats.
Change the calibration coefficients for your logger.

Ruskin can be used on PC and Mac.
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3 Revision history

Revision No. Release Date Notes

1.0 01-Sep-2012 Original

2.0 01-Oct-2014 Adding RBRsolo D and DO and RBRduet
support

B 12-Sept-2017 Final revision for compact loggers

D 12-Dec-2018 Updated installation details, screenshots, 
added auto-deploy features

E 13-Mar-2019 Updated plotting information, firmware 
upgrades, and screenshots

F 06-Jun-2019 Updated introduction, and screenshots

G 04-May-2020 Updated screenshots, RBRcoda T.ODO 
customer calibration, and removal of 
Logger hardware

H 18-Aug-2020 Updated firmware upgrade procedure, 
added annotation collapsing/expanding, 
and GPS plotting
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4 Warranty statement
All data loggers manufactured by RBR are warranted against defects in workmanship or original parts and 
materials for one year. Third party sensors (not manufactured by RBR) are limited to the warranty provided by the 
original manufacturer.

Units suffering from such defects will be repaired or replaced at the discretion of RBR, provided that the problem has 
appeared during normal use of the instrument for the purpose intended by us. The liability of extends only to the 
replacement cost of the instrument. The customer will bear all costs of shipment to us for repair; all other costs, 
including return shipment, will be borne by RBR.

This warranty does not cover consumables or normal wear and tear, nor does it cover damage caused by negligent use 
or mishandling. Attempted modification or repair of any unit without the prior consent of RBR will immediately void any 
warranty in force.

Users are expected to maintain a regular program of calibration.

We reserve the right to grant or refuse warranty repairs at our discretion if we consider that there are reasonable 
grounds for doing so.
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5 Introduction
This document introduces you to Ruskin and helps you to use it effectively from the start. It is specifically written for the 
RBRsolo3 and RBRduet3 loggers - our smallest one and two channel loggers.

You can access the Ruskin User Guide on the USB data stick provided when you purchase a logger, from the Help menu 
in Ruskin, and on the RBR web site, at www.rbr-global.com.

Release notes are automatically displayed each time you install an updated version of Ruskin. The most recent release 
notes are also available from the Help menu in Ruskin. For information about operating and maintaining your data 
logger, see the Logger Hardware section. It helps explain how to change the battery and change desiccant, including 
other useful information, such as inspecting and replacing O-rings.
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6 Installation

6.1 Install Ruskin on a PC
You can install Ruskin on a PC that runs the Windows 7, 8, 8.1, or 10 operating system.

The minimum requirements for Ruskin are:

OS = Windows 7
Processor speed = 1.4GHz 
RAM required = 2GB 
Display resolution = 1024x768 recommended 
HDD space for installation = 500MB

Steps

Connect the data stick included with your instrument to a USB port.
Navigate to the folder Ruskin Installation and double click on the file RuskinSetup.exe.
Follow the installation wizard. By default, Ruskin will be installed to C:\RBR.
The logger uses a USB interface to communicate with Ruskin.
At the end of the installation, a prompt will appear asking, "Would you like to install the logger driver 
at this time?"
Click Yes to install the drivers.

A shortcut to Ruskin appears on the desktop and in a Start menu folder called Ruskin.

6.2 Install Ruskin on a Mac
You can install Ruskin on a Mac running OS X 10.12 (Sierra) or later.

Steps

Connect the data stick included with your instrument to a USB port.
Navigate to the folder OSX and double click on the file Ruskin.dmg.
When the disk image window opens, drag the Ruskin icon into the applications directory and wait for 
the copy to complete.
To open Ruskin for the first time navigate to your applications directory, locate Ruskin, right click on 
the icon, and select Open.

You may need to run the setup application as an administrator to install the driver correctly.

Please note that the most recent version of Ruskin can be found at https://rbr-global.com/products/software

https://rbr-global.com/products/software
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5. The dialogue box shown below will prompt you to authorize the opening of Ruskin. 

An application named Ruskin appears in the Applications folder.

You may want to drag the Ruskin.app application to the Dock.

6.3 Update Ruskin
To take advantage of new features and bug fixes, ensure that you are using the most recent version of Ruskin.

It is not necessary to uninstall an older version of Ruskin before installing a newer version. The installation program 
deletes the older files before installing the newer ones. It does not delete any Ruskin data files or log files.

The most recent version of Ruskin is always available on the RBR website (www.rbr-global.com). However, if you 
already have an older version of Ruskin installed, Ruskin automatically notifies you that a newer version is available 
when you start Ruskin. You can check to see if a new version is available from within Ruskin navigating to the menu Hel
p > Check for updates. If you have a broadband connection, we recommend that you follow the installation 
instructions that appear on your computer. Otherwise, request a USB stick from RBR.  

It may be required that you navigate to System Preferences > Security & privacy to allow apps downloaded 
from “Anywhere” to complete the installation.



Although you can specify a different folder for the working directory for the software, we recommend that you 
use the default Applications folder.



If you do not have a broadband connection and/or are unable to install the Ruskin updates, update 
notifications are available via email. To receive these notifications, send an email to: support@rbr-global.com
subject: "Ruskin update request".



http://rbr-global.com/support/software
mailto:support@rbr-global.com?subject=Ruskin%20update%20request
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6.4 Uninstall Ruskin
If you no longer need to manage RBR instruments from your computer, you can uninstall Ruskin.

It is not necessary to uninstall an older version of Ruskin before installing a newer version. The installation program 
deletes the older files before installing the newer ones. For more information, see Update Ruskin.

Windows 7, 8, 8.1, or 10

Go to Start > Control Panel > Programs, and under Programs and Features, click Uninstall a program. In the list, 
locate Ruskin – click Ruskin to highlight it, and then click Uninstall.

OS X 10.5 or later

Move the Ruskin application from Applications to the Trash.

Removing Ruskin will not delete your data files or your diagnostic logs.
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7 Provide your feedback
You can get in touch with RBR in several different ways:

Send us an email.  For a technical question, write to support@rbr-global.com. For general inquiries, 
use info@rbr-global.com.
Send us a bug report from within Ruskin itself.  Use the Help menu > Comment on Ruskin.  
This allows you to include the diagnostic logs, and any other files (RSK datasets, screenshots) that will 
help us reproduce the problem and help you as quickly as possible.

Steps

From the Help menu, click Comment on Ruskin.
The Feedback to RBR dialog box appears.
Enter your identification information, for example, email address and name, and then summarize your 
comments. 
Provide a detailed description and add any attachments, if required. 
Click Submit to submit the report. 

mailto:support@rbr-global.com
mailto:info@rbr-global.com
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8 Quick start

8.1 Deploy an instrument
Before you begin using your RBR loggers, you may want to experiment with the simulated loggers that are included in 
Ruskin. For instructions on simulating a logger, see Simulating an RBRsolo/duet.

When you are ready to use your own RBR loggers, we recommend that you follow the following steps to ensure that you 
measure exactly what you want on the first attempt. 

Steps

To establish communication between the RBRsolo3 or RBRduet3 and a computer, open the instrument 
(see 'Opening and closing the logger' in the RBR instrument guide for more details) and remove the 
housing. There is a USB-C connector located on the back side of the logger. The supplied interface 
USB-C cable is plugged into this connector and the other end is attached to the USB port on your 
computer.
The logger should appear in the Navigator view after a few seconds.
If you are using the logger for the first time, you can use either the default preferences or specify your 
preferences to apply to all your loggers. For more information, see Preferences. You can change these 
preferences at any time.
Click the logger that you want to use. Ensure that it contains the sensors you expect to find on the 
logger by viewing the Information tab in the Properties view on the right side of the Ruskin window. 
For more information, see View information about a logger.

If you want to see live data sampled every few seconds but not saved, select the fetching ( ) button in the toolbar 
located above the Plot view. The Plot view is located at the bottom of the Ruskin window.

If you want to view or modify calibration coefficients, click the Calibration tab. For more information, 
see Calibration tab.
Click the Configuration tab > Sampling section to schedule the logger to take samples when and as 
often as you want within the limits of your logger.
 For more information, see Scheduling a RBRsolo/duet.

Ruskin prevents you from enabling a schedule that exceeds the memory capacity of the logger. Ruskin also shows the 
estimated battery usage required to use your logger as scheduled. You should seriously consider this information 
before you enable the schedule.

If you want to download data, click the Download button from the Configuration tab to download all 
the data saved since your schedule was enabled. For more information, see Download. The focus 
changes to the new dataset in the Navigator view, and the static data appears in the Plot view. You 

You must specify your preferences regarding these features before you enable the schedule. For more 
information, see Configure a logger.


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can now export the downloaded data to a file in Excel or text. You can also save the image as a PDF or 
PNG file for viewing outside Ruskin.

 

8.2 Batteries
RBR dataloggers can use most chemistries of AA battery. 

We estimate the deployment time based on a capacity calculated from the nominal voltage and miliamp hours (mAh)

Name Chemistry Model Voltage (V) mAh

Lithium thionyl 
chloride

LiSOCL2 Tadiran TL-4903S 3.7 2400

Lithium Li-FeS2 Energizer L91AA 1.5 3500

Alkaline Zn-MnO2 Rayovac AL-AA 1.5 2500

Li-ion LiNiMnCo BatterySpace 
LC14500

3.6 750

NiMH NiMH Duracell 
DX1500B4N

1.2 2400

Lithium thionyl chloride batteries are only recommended for T, D, T.D, and C.T.D instruments. Sensors with 
high in rush current will not work correctly on this type of battery.



The different chemistries affect the deployment time, so ensure you have selected the appropriate battery 
chemistry in the power section of the configuration tab when using the autonomy engine to get the most 
accurate deployment estimate.



Mixing batteries of different chemistries, brands, and age will reduce performance and potentially damage the 
instrument. Batteries that are not matched properly can become overheated, causing them to leak and 
potentially explode.


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8.3 Simulating an RBRsolo/duet
Ruskin can simulate most logger types that RBR produces, including the RBRsolo3 and RBRduet3. We recommend that 
you experiment with your type of simulated logger before enabling a schedule for your actual RBR logger. This practice 
will probably save you time in the long run by ensuring you are familiar with the options available.

Steps

From the Instruments menu, click Simulate instrument. The Configure Simulated Instrument dialog 
box appears.
Under Logger type, select the Compact Instruments tab and select the appropriate options.
Click OK. The simulated logger appears under Instruments in the Navigator window.
Click the new simulated logger. You can work with this logger the same way as you would a real RBR 
logger, including: configuring, calibrating, logging, and downloading data. Multiple loggers, both real 
and simulated, are listed in your Navigator window.

8.4 View information about a logger
You can view static information about a logger at any time as follows:

In the Navigator view, click the appropriate logger.

The Information tab in the Properties window on the right side of Ruskin identifies the logger. Its general information 
such as model, serial number, generation, firmware version, battery status, and the channels.

8.5 Recover an instrument and download data
When the deployment is complete recover your instrument and follow these steps to download your data.

If you want to remove a simulated logger, right-click it and click Disconnect from instrument. You can also 
use the Instruments menu.


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Steps

Start Ruskin.
Carefully open the logger by unscrewing the pressure housing.
Insert the USB-C connector into the logger and connect the cable to your computer.
The logger appears in the navigator window and then navigate to the Configuration tab and select 
Download... (see Download).
Save the file to a preferred location.
Evaluate your data (see Analysis).

Flooded loggers may be under pressure and opening a logger may be dangerous - take precautions when 
opening a logger


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9 Configure a logger
Before you enable a logger schedule, you can configure the logger to suit your requirements.

The instructions to configure a tide or wave logger are different than the standard loggers and can be found in Tides 
and waves.

If your logger schedule is already enabled when you decide to change the configuration you must stop running the 
schedule, make your changes, and enable the schedule again. However, any data stored so far on the logger will be lost.

The Configuration tab contains the Enable, and Use last setup buttons. When you click Enable, the logger setup 
parameters are stored to the logger and the schedule is enabled.

Use last setup is intended for configuring multiple loggers using the same schedule. For example, to set up three |tide 
loggers with exactly the same parameters, set one logger up and enable it; connect the second and third logger and 
when you click Use last setup button, these two loggers will be set up with the same parameters as the first logger. This 
includes the logger clock time, start and end logging times, sampling period (or rate), gating condition, and tide or wave 
sampling parameters for |tide or |wave loggers.

9.1 Autonomy engine
The estimated battery life for the selected deployment is shown in Ruskin's Autonomy Engine in the Configuration tab:

9.1.1 When to replace the batteries
Compared to the cost of deployment, the cost of a new set of batteries is close to negligible. We highly recommend that 
the batteries be replaced before every deployment unless there is no doubt that they have sufficient capacity.

Battery voltage does not decrease linearly and is therefore not an accurate indicator of battery capacity. However, if the 
logger software indicates a yellow or red battery icon on the setup screen, the batteries should be replaced.

You can preserve the data by downloading it to a file before you enable the schedule again.

When in doubt, replace the batteries.
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9.1.2 Predicting battery life
Battery life prediction is a complicated issue. In RBR loggers, battery life is a strong function of the type of logger, the 
type and number of sensors attached, the sampling scheme (sampling period and the use of: thresholding, real-time 
data collection and averaging), and the temperature of the water during the deployment. Manufacturers' data for the 
batteries do not provide information that can be directly related to way the batteries are used in RBR loggers.

The Ruskin software calculates the expected battery usage (in mA hours - mAh) for the logger during setup . The 
nominal capacity of each type of battery is described in the batteries section and is given in mAh at room temperature. 
The software will warn the user if the expected battery usage for a particular deployment scenario is approaching the 
theoretical potential mAh. The software will not prevent a logger from being started even if a warning is given. In tests 
at RBR Ltd. of multiple examples of various brands of batteries at 6°C, all examples were able to provide the threshold 
capacity defined in our batteries section. The user should view these predictions and further de-rate the batteries if the 
expected deployment is in cold water. 

RBR continues to characterize battery life in its loggers and will continue to improve the battery life calculator in future 
versions of Ruskin.

9.2 Scheduling a RBRsolo/duet
You can schedule your RBRsolo3 or RBRduet3 to start at a specified time and sampling rate. Ruskin indicates any 
unattainable conditions in the defined schedule at the bottom of the Configuration tab, and the Enable button is 
grayed out.

Steps

Connect your logger locally to the computer's USB port. The logger should appear in the Navigator
view after a few seconds.
While the logger you want is highlighted in the Navigator view, click the Configuration tab in the 
Properties view.

Click either UTC sync to synchronize the logger with Coordinated Universal Time, or Local sync to 
synchronize the logger with your local PC clock.
In the Start boxes, specify the date and time that you want to start running the schedule or select 
the Now checkbox to populate the current date and time.
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Specify the interval between samples using the Speed option. If the Rate box is not selected you have 
the ability to set the sampling interval in units of seconds. The Rate option allows you to select 
between 2,4,8,16,24 and 32Hz frequencies.

 
An estimated end logging is shown at the bottom of the Configuration tab based on the sampling 
interval set. Check to ensure this date is beyond the end date of your planned deployment. The green 
and red bars next to the End date shows whether memory or battery is the limiting factor for the 
deployment. For the above instrument, it can log for 16.1 days based on memory, with a further 24.2 
days of battery capacity remaining. 
If the logger you are scheduling has had a fresh battery inserted, select the Fresh battery box. Ruskin 
has the capability to calculate the remaining battery life available for a used battery based on the 
number of samples that have been taken. The RBRsolo3 and RBRduet3 keep track of the number of 
previously stored samples to determine the battery use. Selecting and deselecting the Fresh Battery
checkbox allows you to see the difference between a fresh battery and a used battery.

 To enable the logger to start sampling immediately or in the future click Enable. A message appears 
informing you that the memory will be erased. 
 Select Cancel if you need to download the previously sampled data or press Erase and enable 
logging to enable the logger.

9.3 Stop logging
Logging stops on its own when one of the following occurs:

The end logging time is reached.
The gating condition is no longer met.
The power is removed or depleted.
The logger memory is filled.

To manually stop the logger, highlight the logger in the navigator, click the Configuration tab and select Stop.

 

If you select and then clear the Now checkbox, you can then manually modify the current date and time 
instead of the original values.



All profiling loggers (known as |fast) have the ability to sample faster than 2Hz. For example |fast32 
loggers sample at rates of 2,4,8,16,24 or 32Hz. All |tide loggers can average at rates of 2,4,8 or 16Hz. All |
wave loggers can sample at rates of 2,4,8 or 16Hz



If you select the Fresh battery box and enable the logger the previously stored sample count is reset. In 
this case, it is assumed that a fresh battery is installed.


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9.4 Tides and waves

9.4.1 Tides 

Tide is a sampling mode which collects data at a certain rate then averages those samples to produce a single value 
which is stored in the logger memory. This mode uses averaging to remove wave data from the pressure 
measurements.

There are three main parameters required to be configured for averaging mode:

Speed: Specifies the rate at which samples will be collected.
Duration: Specifies the time range over which to average.

The Duration must always be longer than the sampling Speed.
Interval: The repetition period for performing the averaging.

The Interval must always be longer than the Duration.

This sampling mode can be activated by selecting Tide in the Mode drop down menu in the Sampling section on 
the Configuration tab

There are two versions of the Tide Sampling section that can be used, either simple or advanced. This option can be set 
in Preferences.

 Simple form:

 Advanced form:

This section applies to loggers with the |tide16 or |wave16 feature
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In the example above, 1 minute of 8 Hz (8 times a second) samples are taken and averaged. This cycle repeats every 5 
minutes.

9.4.2 Waves

Wave is a sampling mode which collects a specified number of samples at a specified rate and repeats this operation at 
a specified interval. This mode records both wave and tide information. For additional information on planning a wave 
deployment, please refer to |wave deployment planning.

There are three main parameters required to be configured for averaging mode:

Speed: Specifies the rate at which samples will be collected.
Duration: Specifies the number of samples to record.

The range is between 512 and 32768 samples.
Interval: The repetition period for performing the burst.

The Interval must always be longer than the time it takes to obtain the specified number of 
samples.

Wave bandwidth statistics can be generated by specifying two other parameters:

Instrument altitude: Specifies the number of meters above the sea or river bed where the logger will 
be mounted.
Mean depth of water: Specifies the total expected depth of the water in which the logger will be 
deployed.

A single averaged sample is recorded at the Interval rate. All other samples used to perform the average 
operation are discarded.



This section applies to loggers with the |wave16 feature

All |wave loggers automatically calculate tide data by averaging the wave burst data. There is no setup 
required to determine tide information with the wave logger. 


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This sampling mode can be activated by selecting Wave in the Mode drop-down menu in the Sampling section on 
the Configuration tab

There are two versions of the Wave Sampling section that can be used, either simple or advanced. This option can be 
set in Preferences.

Simple form:

Advanced form - sampling at one second or slower:

Advanced form - sampling at 2, 4, 8, and 16 Hz

The Mean depth of water parameter is not stored on the logger. It is only used to compute wave bandwidth 
statistics for pre-deployment analysis.

The Instrument altitude parameter is stored in the logger and is used to calculate wave statistics. This 
parameter can be adjusted post-deployment through the RSK file.


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9.4.3 |wave deployment planning
The following provides a guideline to establish a coherent deployment for |wave loggers.

The |wave logger should be fixed to a suitable support below the surface of the water, such as a dock or other rigid 
mooring. The logger must not be able to move in the water. The figure below offers a view of the logger fixed to a dock 
with a definition of the different water heights.

Mean depth of water: an estimate of the average water depth, used for the initial prediction of 
expected wave frequencies that can be detected. Ruskin will use the actual depth measured by the 
logger for its calculations.
Instrument altitude: The actual height of the logger above the seabed. This is defined by the 
deployment, and the logger must be physically affixed at this height during the installation. 

Given the height of the logger above seabed and the depth of logger as measured during the deployment, the total 
depth of water can be calculated.

Figure 1. Logger positioning

The timestamp of the burst for both a Tide and Wave datasets is the beginning of the burst.
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|wave logger positioning
For deployment planning, refer to Figure 1. Ruskin needs to know the expected mean depth of water (in metres) and the 
expected altitude (height) of the logger above the seabed to provide an estimate of the frequencies and periods of the 
wave that the logger is able to measure. The logger measures water depth/pressure by means of a pressure transducer. 
The physics of what a pressure transducer can 'see' at depth depends on the height of water above the transducer as 
well as the amount of water below the transducer. High frequencies attenuate very quickly with depth. Figure 2 shows 
the attenuation with depth as a function of wave period in seconds (period = 1/frequency). This graph demonstrates that 
the placement of the logger is critical in determining frequencies/periods of the wave data to be captured by the logger. 
The pressure transducer may be placed in any orientation.   

 The basic rule is to place the logger as close to the surface of the water without the possibility that the logger 
will emerge from the water either because of large waves or low tides.

Figure 2. Wave attenuation as a function of depth for various wave periods. 

This step in the deployment configuration requires that the 'expected mean depth of water', that is the total depth of 
water known from experience with the measurement site, and the 'expected altitude of the logger above seabed', a 
definition to be given to the diver, be entered. Note that on data retrieval the second value will be added to the 
measured depth of water above the logger when performing all wave calculations. 
When waves are enabled, the logger takes multiple pressure readings in a burst which allows for the reconstruction of 
the surface wave time series. There are three parameters which define the wave data:

Measurement speed: this defines the sampling rate or period for individual pressure readings used.
The rate possibilities are 2, 4, 8, and 16Hz
The sampling rate defines several elements of the data capture:

The highest possible frequency visible in the data is limited to ½ the sampling frequency. 
However, this mathematical limit can not usually be achieved because of the attenuation 
characteristics shown above. 
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The sampling frequency defines the resolution of the frequency spectrum which can be 
calculated from the wave data. 
The sampling frequency, together with the burst length, define the lowest frequency 
which can be assessed in a wave burst.

Wave measurement period: this defines how often wave bursts are collected.

Burst Length: this defines the number of samples in a wave burst. It must be a power of 2 and is 
chosen from the list: 512, 1024, 2048, 4096, 8192, 16384, and 32768. The longest wave period to be 
assessed is defined by: burst length/sampling frequency

The wave parameters work together to define the range of wave information which can be calculated as well as the 
memory and battery usage. 

9.5 Autoranging and fixed gain
Turbidity sensors are capable of autoranging. The logger can change the gain setting on the front-end amplifiers in 
order to select the most appropriate range based on the environment being measured. The logger can also set the gain 
on the sensor to a fixed value selected by the user, rather than allowing the logger to select the gain as it measures.

From the Configuration tab under logger details there is a drop down menu where the Range of the sensor can be 
specified. Seapoint turbidity sensors are capable of autoranging (automatic gain setting) or having a fixed range of 
2500, 500, 125 or 25 NTU.

Range change events are displayed in the Plot view when the Display diagnostic is selected from the Events button, 

, located in the Plot view toolbar. Range change events are displayed as RANGE XX Units where XX indicates the 
current range and units are the units of the sensor – typically NTU for turbidity sensors and μg/l for fluorometers. For |
fast sampling where the change may be occurring over a number of samples the event is displayed as RANGE CHG and is 
followed by the final range event.
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9.6 Derived channel parameters
When configuring your logger, you can change the default values of parameters that are used to calculate derived 
channels.  These values are stored in the logger itself and are used in place of the values in Options menu > 
Preferences > Derived channels.

In the Parameters tab, you can configure the parameters which are used to calculate derived channels on a logger that 
supports derived channels.  

9.7 Deployment

Once you have ensured that the batteries are fresh, inspected the O-rings, and programmed the logger (see Configure a 
logger), the instrument is ready to be deployed.

There are four precautions you should take to avoid damaging the logger and maximize the deployment autonomy:

Pay attention to the maximum pressure rating. All loggers with pressure sensors are individually rated 
to a maximum depth/pressure. This is indicated by the label which is placed on the logger's sensor 
end cap. Loggers that do not have a pressure sensor do not have this label but are limited by the 
maximum depth/pressure rating of either the logger housing itself or of the sensors.
Avoid physical stress to the logger. Any type of clamp or bracket which concentrates the stress to the 
logger body is not recommended for use in logger mooring, mounting, and/or other deployments. 
Stress due to improper mounting may cause the logger to leak, resulting in the loss of valuable data or 
permanent damage to the electronics. RBR can provide proper mooring and mounting clamps suited 
to your specific application.
Use desiccant. If the logger is closed up in a warmer environment than the deployment environment, 
internal condensation can result. Since condensation may cause the circuitry to malfunction, the 
installation of desiccant prior to deployment is strongly advised.
Be careful of the orientation on a mooring. Due to battery capacity potentially being sensitive to cell 
orientation, it is best to mount the logger with the sensor end facing down when deployed. Even if 
batteries that are minimally sensitive to cell orientation are used (e.g. Tadiran), it is always good 
practice to mount the loggers in this manner in the event that any brand of battery is employed.
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9.8 Automatic tasks
When working with a large number of similar instruments, Ruskin offers various automatic tasks, which can be toggled 
on and off from the Instruments menu, or by right-clicking the "Instruments" group in the navigator view.  Icons 
indicating the current state will be displayed on the "Instruments" group.  Since these tasks can change the state of the 
logger, the on/off state defaults to off each time Ruskin is run.

Figure 1.  Instruments menu showing automatic tasks options.  If a task is enabled, it will show a check mark.

Figure 2.  Right-clicking on the "Instruments" group of the navigator view will show the automatic tasks.  If a task is 
enabled, it will show a check mark.

Figure 3.  "Instruments" group of the navigator view with icons indicating that auto-download and auto-deploy are 
enabled.

9.8.1 Auto-download
When an instrument is detected, it will automatically start a download process and store the file using the common 
logger download naming scheme (serial number, date and time of download) in the last "save to" directory chosen.  
Other than possibly creating unwanted files, this option is safe since it does not alter the state of the logger.
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9.8.2 Auto-stop
When an instrument is detected, it will automatically stop the instrument if the instrument was previously enabled.  If 
auto-download is not also selected, a warning will be displayed about downloading the instrument data.  It is not 
possible to re-enable the instrument without erasing the instrument's memory, so it is advised to also use the auto-
download feature at the same time, or ensure that the data is downloaded prior to re-enabling the instrument.

9.8.3 Auto-deploy
When an instrument is detected, the instrument will be stopped and then reprogrammed with the last known 
configuration settings.  It is highly recommended to also use auto-download with this setting since the instrument 
memory will be erased during the deployment set up.  To use this feature, first connect an instrument that will act as 
the model and configure that instrument with the desired settings and then turn on auto-deploy.  Each instrument 
connected, if it supports the same capabilities of the model instrument, will be configured to match the scheduling of 
the model instrument.  Auto-deploy implies auto-stop since the instrument must be stopped to update it with the new 
schedule information.
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10 Download

10.1 Download data from the logger
You can download data from a logger at any time. If you stop running a schedule, you must download the data before 
you restart the schedule to prevent the data stored so far from being lost. It is not possible to start logging without 
erasing the memory contents.

Steps

From the Configuration tab select Download. 
The Save as RSK dialog box appears.
Specify a location and a name for the data file. 
By default, the RSK file name uses the Ruskin file naming convention. For more information about the 
naming convention, see File naming convention below. 
The name of the new dataset appears and is highlighted automatically in Navigator view > Datasets. 
The Properties view changes to the new dataset and contains the following tabs: Analysis, Overview,
 Channels, and File Info. All the data that was stored on the logger at the time of the download is 
automatically plotted in the Plot view.

10.2 File naming convention
In Ruskin, by default, the name of a data file is composed of the following information:

The first six digits represent the logger serial number.
The next eight digits represent the current year, month, and day.
The next four digits represent the current time to the minute.
The file extension indicates the file format and should not be changed. If you change it, the file 
extension that you specify becomes part of the name, and the required extension is appended.

For example, the file named 911936_20090522_1613.rsk contains data for a logger with a serial number of 911936 
whose data was downloaded in 2009 on May 22 at 4:13 pm.

Downloading data again while the same schedule continues to run, picks up the same data plus any data 
stored since the last download.

You can add a comment after downloading a dataset.


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11 Calibration tab
The Calibration tab displays the calibration coefficients for each parameter (sensor) present and the date and time of 
the last calibration. Selecting the sensor from the dropdown menu Parameter toggles between the calibrations for the 
different sensors on the unit.

You can request a calibration quote for your logger by selecting Request calibration quote and sending the 
information directly to RBR Ltd. In the Calibration tab, click Request calibration quote, and when the Request 
calibration dialog box appears, enter the appropriate information. Make sure to verify that all information is correct 
before sending the request. You can edit any of the coefficients and use Store calibration to save the new coefficients 
to the logger.  Use Revert calibration to recover to the original coefficients if you have not already selected Store 
calibration. 

Calibration coefficients are calculated for each sensor, and the coefficients are stored in the logger. Calibration 
certificates are provided for each sensor and contain both the calibration equation and the coefficients. Hard copies are 
provided with each shipment, and the documents are contained inside the shipping box. Please refer to the calibration 
certificates for the coefficients and residuals. RBR can replace lost or misplaced calibration certificates.
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12 Update firmware
Instrument firmware upgrades can be performed from within Ruskin without having to return the instrument to the 
factory. Ruskin automatically checks to see if a newer version of firmware is available and displays a message in the 
Information tab.

Click the Update firmware button to upgrade the logger firmware. The following screen will appear:
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If for some reason RBR needs to supply a version of firmware, the following method is used to manually update the 
logger firmware.

Click the Instruments menu > Update instrument firmware. 

Steps

In the Instruments menu, click Update instrument firmware. 
The Update logger firmware dialog box will appear. 
Click the instrument drop down to select the instrument you wish to upgrade.

A default firmware image will be selected for your instrument. 
If RBR supplied a firmware file see Manually adding a firmware image to Ruskin

Click Proceed to start the firmware upgrade. 
A progress bar shows the status of the upgrade. Once the firmware upgrade is complete, the message 
Update completed successfully appears at the top of the dialog box.
If the upgrade doesn't complete successfully, click Proceed again to retry until successful. 

Do not disconnect the logger until the process is fully completed. Disconnecting the logger during this process 
may render the logger inoperable.



Contact RBR for instructions before proceeding. This method of updating the firmware should only be 
attempted with the assistance of RBR.


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Click Close.

12.1 Manually adding a firmware image to Ruskin

If for some reason RBR needs to supply a version of firmware, the following method is used to manually add that 
firmware image to Ruskin.

Click the link at the bottom of the Update instrument firmware dialog.

Click the Select file button and browse to the location of the firmware update file provided. The file 
will have the extension .rbrfw.
Click Import.
Click Close.

Occasionally the logger will not reappear in the Navigator view following a successful upgrade. If this 
occurs, disconnect your logger from the USB port and then reconnect to re-establish communication.


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13 Datasets

13.1 Open a stored dataset
You can open any stored dataset to explore its contents.

Steps

Click File menu > Open dataset. 
Double-click the .rsk file that contains the data that you want to view. 
The name of the dataset appears and is highlighted automatically in the Navigator view. The 
Properties view changes to the dataset. The data in the file is automatically plotted in the Plot view.

13.2 Analysis

13.2.1 Analysis tab
The Analysis tab contains information and settings for configuring the calibration information and to display statistical 
information. You must already have an open dataset to view and configure these settings. For information about how to 
open a dataset, see Download.

Cursor tab
When a file is selected and plotted, the Analysis tab can be selected to display information about the dataset channels 
and their values.

To close a dataset, right-click its name in the Navigator view and click Close dataset. Or use File > Close 
dataset



Ruskin performs an integrity check that is intended to make sure that older data files are compatible 
with newer versions of Ruskin software. This information is displayed in File info. If the file requires 
updating the message indicates the issue with the file, and how long an update will take.

RBR strongly recommends that all files that have issues be updated.


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This table reports the value at each sample number when selected in the plot referenced to the vertical black cursor.

The sample number and time of the sample are displayed.

Selecting Display statistics gives you the ability to determine the average value and standard deviation over a range of 
samples. Change the number of samples in the average by using the spin buttons. The grey bar that appears on the plot 
view is the range of the samples in the average.
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Calibration tab
When a file is selected and plotted for re-calibration the Calibration tab can be selected to assist with calculating 
calibration coefficients, see User calibration .

13.3 Overview
When a file is selected and plotted the Overview tab can be selected to display general information about the dataset.

This is also the form on which you can enter a comment for the dataset and then press Save comment to save it.
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13.4 Channels
The Channels tab displays three additional tabs: Information, Calibration, and Parameters.

The Information tab displays the measured parameter, the sensor manufacturer and the range 
setting. The type of derived channels and how it is calculated is displayed in a separate table.
The Calibration tab displays the calibration coefficients for each sensor.
The Parameters tab displays the values of the parameters, default values if other required 
parameters are required and the method used to calculate the derived channels.

13.4.1 Information tab
The Information tab displays the measured parameters, the sensor manufacturer and the range setting (if applicable). 
It also shows any derived channels that are available and a description of the methodology used in the calculation of 
that derived parameter.

13.4.2 Calibration tab
The Calibration tab displays the calibration coefficients and temperature correction coefficients (as applicable) for 
each channel (sensor) and the date and time of the last calibration.
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You can edit any of the coefficients and use Store and recompute data to recalculate the dataset. Use Revert 
calibration to recover to the original coefficients if you have not already selected Store and recompute data. To 
recover the original calibration coefficients edit one of the values and click in another cell. The Use deployment 
calibrations checkbox then becomes active and unchecked. Check this checkbox to restore the coefficients used by the 
logger and then press Store and recompute data to save the coefficients.

13.4.3 Parameters tab
When a file is selected and plotted, the Parameters tab can be selected to display the parameters used to calculate any 
applicable derived channels.

The tab reports the relevant derived channel information for the sensors on the logger. The parameters can be edited to 
change the derived channel calculation. Once a parameter is modified, the Update and recompute and Revert 
settings buttons become active.

Revert settings rereads the RSK file and populates the form with the parameters from the file. Update and 
recompute writes the new parameters to RSK file and re-displays newly calculated data.

The following example is for a  CTD and dissolved oxygen logger where you can change the calculation parameters to 
calculate the derived channels:
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Selecting the Seawater derivation in the Parameters tab results in a depth calculation based on UNESCO Technical 
paper 44.

The depth derivation equations can be found under the menu item Options menu > Preferences > Derived 
Channels > Depth tab. 

For |wave loggers, you can change the wave calculation by adjusting how the depth is calculated and by adjusting the 
instrument altitude. This function is available in the 'Configuration' tab and under the 'Sampling' tab.

13.5 File info
When a file is selected and plotted the File info tab can be selected to display information about the file.
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If the message A new version of the RSK file format is available. appears, click Update. The update process may take 
some time, however, Ruskin does estimate the time with the message The anticipated update duration is <time period>. 

13.6 Plot view
You can use the Plot view to view a graphical display of data in datasets or live data. When viewing live data, the logger 
must still be attached.

A toolbar at the top of the Plot view contains various buttons to help you customize, explore, and export the graphical 
display.

Each channel appears as a different colour in the graphical display. These colours are specified for all graphical displays 
in Options menu > Preferences > Plotting and can be changed there only. You can also change other defaults affecting 
the Plot view in Preferences. For information, see Specifying plotting preferences

You can click a particular time (location) in the plot to view each channel value and related statistics at that time. A 
"double lollipop" vertical black line marks the place. The Cursor tab panel above (or on the side of the plot for live data) 
displays the channel values, units, the sample number, and the time that the data was measured.

For datasets only, you can select the Display statistics checkbox to view the average value and standard deviation for 
each channel based on the number of samples that you specify. 

If you want to copy the data to the clipboard and then paste it into another application, select a row, a column, a cell or 
click on the word channel for the entire table and then click Copy. 

The graphical display for each dataset appears on its own tab in the Plot view. The dataset file name appears at the top 
of the tab.

Files created by older versions of Ruskin must be updated to ensure compatibility. Failing to do so may result 
in odd graphical display and incorrect reporting of the sample values.



Scaling of the data is based on the minimum and maximum value sampled for each channel - sometimes there 
are erroneously high or low values that may make the real data appear incorrect. Use the vertical zoom 

 to increase the scale of the data displayed.


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13.6.1 Thumbnail view
A downsampled representation of the dataset appears in a thumbnail view, along with an indicator of the current 
plotted time range.  The indicator can be positioned on the thumbnail view by clicking on the thumbnail view or 
dragging the indicator.  The indicator can be resized by dragging the edges, which will zoom the plot along the time 
domain to match the new indicator size.  The thumbnail always shows time-domain data, even if the plot is switched to 
depth-domain mode.

13.6.2 Live data
You can use the Plot view to view a graphical display of logger sampling.  The data can come from one of two sources: 
fetching or streaming.  Fetching can be used on a logger that is either not enabled or enabled without a streaming 
option.  Streaming can be used on a logger that has been enabled.  If fetching is used on a logger with streaming 
selected and the logger is enabled, the current file used for the fetching data will be closed and a new file started for the 
streaming data; fetching will be disabled.

The graphical display for live data for each logger appears on its own tab in the Plot view. The logger model and serial 
number appear at the top of the tab.

13.6.3 Plot Tools

Dataset toolbar

Live data collection support in Ruskin is intended for debugging, development, and schedule trial purposes 
only and is not intended as a robust data collection solution.  The performance will degrade significantly if 
large (>50-100K samples, depending on hardware) data collections are performed, especially if there are a 
large number of events being reported.


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Live plot toolbar
The live plot toolbar appears to the right of the dataset toolbar.

Tools for datasets and live data

Button Purpose Use

Filter Changes the type of annotation for the navigation 
buttons

If an annotation is selected, switching filters zooms the 
view to the newly selected annotation.
If no annotation is selected and switching filter from one 
profiling annotation type to another (profile, upcast, 
downcast), the view does not change.
If no annotation is selected and switching filter between 
categories (profile, upcast, downcast to any other non-
profiling annotation type, or any non-profiling annotation 
type to any other annotation type), the view moves to the 
first annotation of the new category.

Comment → Profile moves to the first profile
Profile → Comment moves to the first comment
Comment → Downcast moves to first downcast
Profile → Downcast does not move.

Move to 
first, 
previous, 
next, and 
last

Move to the first, previous, next, and last annotation of 
the filter type

If the annotation is selected also moves the selection

Index The current annotation index, which can be edited.

If the currently selected annotation matches the time 
domain extent the text will appear blue, otherwise the 
text will be red

Click the middle of the index (the '/' ) to zoom to the 
annotation.
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Button Purpose Use

Create 
annotation

Select the type of annotation to create.

After selection, click and drag left/right on the main plot 
to create the annotation. When the click is released the 
annotation will be created as a temporary annotation, 
selected, and show its editable tooltip.

Profiles or geodata cannot overlap the same type - new 
annotations will fill the available space between existing 
profiles.

Cast 
detection

Runs a cast detection algorithm based on depth and 
conductivity to automatically generate profiles and casts

Event 
visibility

Turn on and off the visibility of the various levels of events 
(error, warning, information, and diagnostic)

The annotation must be edited (such as adding a 
title or description, or, in the case of profiles, by 
adding an up or downcast) and saved (press 
ENTER/Return, or click the green checkmark on 
the tooltip) before it will be saved in the RSK file.



Only available in the time domain

Overwrites logger generated cast events and 
profiles


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Button Purpose Use

Annotation 
collapse

Toggles the annotations collapse or expanded state for 
an entire category of annotation.

In the expanded state all data within the time bounds of 
the annotation will be displayed.

In the collapsed state all data within the time bounds of 
the annotation will be hidden and a time break marker 
will be visible on the time axis. The annotation marker 
will appear as a point annotation.

Individual annotations can be collapsed or expanded 
from the toolbar in the annotation bubble.

Zoom 
control

Zoom in/out horizontally, vertically, and reset the zoom 
to display the maximum extent of each axis

Zooming the range will centre the data on the currently 
selected sample.

Auto-
ranging

Toggles the auto-ranging of the channel axes

Export plot Exports the current view of the main plot to pdf or png

Disabling the auto-ranging of the axis can be 
useful for looking at trends in data


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Button Purpose Use

Data 
rendering 
type

Choose lines, shapes, or lines and markers for the trace 
lines

Toggle 
channel 
visibility

Turn on or off channels to be visible in the plot view

Toggle on raw values removes the calibration equation 
from the sensor value

Plot by 
depth

Toggles between plot by time and plot by depth

Show GPS 
map

Launches a map which plots all the GPS location 
annotations in the dataset. The map will infer track lines 
based on the timestamps of the acquired locations.

If no data appears in the Plot view, try changing 
the rendering to "Display Markers".  Time spans 
that are larger than expected will cause breaks 
between data points and lines will not be drawn 
connecting those points, whereas markers draw 
at each individual point.



If there is no depth channel the plot would then 
use the next pressure or pressure derived channel 
starting from the bottom of the channel list


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Tools for live data

Button Purpose How to use

 
Toggle the 
side data 
panel

The side data panel appears beside the charts and shows the 
file location that will be used to capture samples, the number of 
samples collected, the values of the last received sample, and 
the currently selected sample.  The side panel can be toggled on 
and off with this button.

Live plot time 
range 
selection

Click the button to display a drop-down list of time span 
options to display the data by time period. For example, display 
2 minutes of data. You can also choose to display all of the data 
collected.

Start or pause 
fetching

The logger supports either streaming or fetching data. Fetching 
is the action of asking the logger to take a reading and report it. 
Ruskin displays the fetched data every 1-2 seconds. Fetching is 
disabled if the logger is enabled and has streaming turned on.

13.6.4 Shortcuts / Controls
Data cursor:

Click on the main plot to set the data cursor (double lollipop indicator).
Move to the previous/next data sample: Left/Right Arrow Key

To move by hundreds of samples, use Shift - Arrow
To move by ten thousands of samples, use Alt - Arrow
To move by millions of samples, use Shift - Alt - Arrow

Annotations
Double click on an annotation bar to zoom in to the range of the annotation.
Click and drag on the edge of an annotation bar to resize the annotation, if the annotation is 
resizeable (CELL GPS annotations are not).
Click and drag on the annotation bar to move the annotation, if the annotation is moveable 
(CELL GPS annotations are not).

Main Plot
Double click on the plot to reset to fully zoomed out.
Shift-click and drag on the plot to select a zoom region.  The zoom region will be denoted by a 
rectangle.  Make sure to press shift before clicking.
Control-click and drag on the plot to pan the plot.  Make sure to press control before clicking.
The mouse wheel will zoom the plot in/out based on the current mouse position.

Main Plot Axes
Double-click on an axis to set the axis to auto-range (show the full range of data).
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Click and drag an axis to pan the axis.
Shift-click and drag an axis to zoom the axis in or out.
The mouse wheel will zoom the axis in/out based on the current mouse position.

Thumbnail
To resize the viewable range, click and drag on the handles (grey bars) on or use the mouse 
wheel within the viewable range indicator.
Click and drag the viewable range indicator to pan
Click on a region not covered by the viewable range indicator to centre the viewable range at 
that location.

13.7 Exporting datasets
You may want to share your data with others or analyse your data using other software. You can export data as a text 
file, which can then be imported into many applications, or export it in a particular format for analysis such as Microsoft 
Excel or OceanDataView.

You must already have downloaded the data to a dataset or opened an existing dataset.

Steps

Right-click the dataset whose data you want to export, and hover to Export as to open a submenu, or 
use File menu > Export dataset.

Select the appropriate export format (Excel, Text, OceanDataView or Bin).

Specify a location and a name for the data file. 
Click Save.

Annotations can be exported to individual files by selecting the annotation category you would like to 
export. 



RSK files can be imported directly into Matlab with our toolkit RSKtools that is available for download 
from our website at www.rbr-global.com. The RSK file is a single file database based on SQLite that 
allows us to have very large files with high-speed access to any part of the dataset.



http://rbr-global.com/support/matlab-tools
http://www.rbr-global.com/support/matlab-tools
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14 User calibration
Change calibration coefficients

Sensors such as the dissolved oxygen sensor that can be field calibrated will require you to update the calibration 
coefficients for these channels periodically. You may also need on occasion to manually enter new coefficients, 
although this is not recommended for factory calibrated sensors (for example T or D) unless instructed by RBR.

Steps

You can view static information about an instrument at any time as follows:

In the Navigator view, under the Instruments list, click the appropriate logger.
Click Analysis tab > Calibration tab to show the current calibration coefficients.
To manually change a coefficient, click on the appropriate entry in the table (C1, C2, C3, etc.). The 
current entry will be highlighted, and the new value can be typed.
If a two point calibration has been performed, and calculated coefficients have been copied, right click 
on either the Time or Parameter entry for the parameter you wish to modify. Select Paste to selected 
row from the drop down menu.
Click Store calibration to write the calibration coefficients to the logger.
If you need to revert to previous coefficients, click Revert calibration.

14.1 N-Point calibration
Sensors such as Dissolved Oxygen (Oxyguard) or turbidity generate a voltage output that is proportional to the value of 
the parameter being measured. To calibrate these sensors, Ruskin offers an N-point calibration method to generate 
calibration coefficients.

14.2 Oxyguard DO calibration

Equipment and Materials

Two Large mouth beakers.
Sodium sulphite Na2SO3
Aquarium air pump.
Magnetic stirrer.

If you do not click Store calibration, the coefficients will not be written to the instrument, and will be lost 
once your session is closed. 



The Oxyguard DO sensor has a true zero point and therefore it can be calibrated using the single-point 
calibration method using a reading at 100% oxygen concentration only. The 100% calibration should be 
performed at the expected temperature and salinity of the deployment environment.

If the logger has a pH/ORP sensor and Oxyguard DO sensor, it is advisable to ensure that the pH/ORP and 
Reference sensors are submerged in the water during measurement.


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Water

Preparing solutions

 Reference Point 1 solution – Oxygen saturated solution at expected temperature and salinity of deployment 
environment

Fill the large beaker with 2 L of water and install magnetic stirrer.
Bubble air through the water using an air pump (an aquarium air pump would work).  
Switch ON the air-pump and the magnetic stirrer.

Reference Point 2 solution – Dissolved oxygen concentration of zero

In a beaker, dissolve approximately 5 tsp of sodium sulfite (Na2SO3) into 500 mL tap water.  
Mix the solution thoroughly with a magnetic stirrer. The solution will be oxygen-free after 15 minutes. 

Steps

In Ruskin, configure the instrument to sample at a fast rate, between 6 Hz and 3 seconds. 
Use Sync to PC to ensure the logger clock is synchronized to the PC clock, and ensure the end time is 
set so that the logger will keep sampling until calibration is complete.
Submerge the dissolved oxygen sensor in the Reference Point 1 solution for at least 15 minutes near 
the stirrer so that it is in the best mixed area of the bath.
Take sample readings for at least 15 minutes for the 100% calibration point, making note of the time 
that the sample is being measured.
Submerge the dissolved oxygen sensor in the Reference Point 2 solution for at least 15 minutes for the 
0% calibration point, making note of the time that the sample is being measured.
Retrieve the data from the data logger as per the steps in Download.
The calibration data should now be displayed in the Plot view. In the Properties view, go to Analysis
tab > Calibration tab.
Select the dissolved oxygen sensor type from the drop down list. 
The Number of Samples spinner box is automatically set to 100. 
This value is the number of sample points Ruskin will average the calibration coefficients for the 
sensor. Typically, this value should be in the range of 50 to 100 samples.
Click on a stable point in the Plot view corresponding to 100% oxygen. In the table in the first row, 
under Real Avg, enter 100 and press enter. 
Select the check box in the second row in the table, then click on a stable point in the Plot view 
corresponding to 0% oxygen. In the table in the second row, under Real Avg, enter 0 and press enter.
Ruskin automatically calculates the calibration coefficients, and these values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.
Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the data 
logger.
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14.3 Turbidity calibration
The Seapoint turbidity sensor is calibrated by RBR with a two-point calibration technique. We recommend doing a two-
point calibration performed under fluorescent lighting.

Alternatively, one can do a single point calibration. If doing a single "0" point calibration in distilled water the 
calibration will only correct the coefficients for an offset.  If only a single non zero point is performed the calibration will 
recompute the slope coefficient. We recommend to only perform a "0" point calibration unless you are confident on 
your non zero standard.
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14.3.1 Two-point calibration
Equipment (entire logger submerged)

4000-FTU Formazin standard – 500ml
Distilled water – 5 L
Black-walled, wide-mouth container (large enough to hold the logger)
Volumetric flask 1000 ml, class A
Volumetric flask  200 ml, class A
Stir stick

Steps (preparing solutions)

In Ruskin, configure the data logger to sample using a 10-second sampling interval and set the sensor 
to autoranging - see Autoranging and fixed gain. 
Use Sync to PC to ensure the logger clock is synchronized to the PC clock, and ensure the end time is 
set so that the logger will keep sampling until calibration is complete.
Flush the sensor, container and glassware with distilled water and dry them.
Fill the black wall container with 5000 ml distilled water using the large volumetric flask.
Set the sensor in the container until the sensor is fully submerged in the distilled water. 

Record the data in distilled water for five minutes. 
This is the zero-turbidity calibration point.
Fill the 500 ml volumetric flask with Formazin Standard. Remember to gently shake the bottle before 
opening the Formazin solution.
Add 500 ml Formazin Standard to the black wall container with distilled water, and gently mix the 
solution with a stirring stick.
Calculate the value of the standard turbidity solution at calibration point according to the following 
formula: 
 

After five minutes, remove the logger from the calibration container and wash the sensor head under 
regular tap water.
Retrieve the data from the data logger as per the steps in Download. 
The calibration data should now be displayed in the Plot view. In the Properties view, go to 
the Analysis tab > Calibration tab.

If you plan to submerge only the sensor, you can decide on the container volume and adjust the solution 
volumes appropriately.



The distance from the sensor's windows to the container wall must be at least 20 cm. If possible, place 
a dark cover on the calibration container and avoid direct light on the container.



Calculating dilution

TuSTD = TuSTK*VTOT/(VDW+VTOT) = 363.63 FTU
Where:
TuSTD = turbidity of the standard solution (FTU)
TuSTK = 4000FTU – turbidity of the stock solution
VTOT = 500 ml volume of stock solution at calibration point (ml)
VDW = 5000 ml - initial volume of distilled water


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Select the Turbidity sensor type from the drop-down list.  
The Number of Samples field is automatically set to 100. 
This value is the number of sample points Ruskin will average to calculate the calibration coefficients 
for the sensor. Typically, this value should be in the range of 50 to 100 samples.
Click on a stable point in the Plot view corresponding to 0 NTU. In the table in the first row, under Real 
Avg, enter 0 and press enter. 
Select the checkbox in the second row in the table, then click on a stable point in the Plot view 
corresponding to the reading of your turbidity solution. In the table in the second row, under Real 
Avg, enter the value of your turbidity solution and press enter.
Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.
Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the data 
logger.

By using the above formula and changing the volume of distilled water and Formazin solution, you can 
prepare different calibration points or different volumes for checking the linearity of the turbidity sensor or 
getting close to real turbidity value of standard turbidity solution.


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14.3.2 One-point calibration
Using the same procedure as in the 2-point calibration, one can use only the distilled water or formazin standard to 
generate new coefficients from a single point.

RBR suggests using the one-point calibration for establishing a new "0" value only, as unless one is very confident on 
their non zero point they may put the unit out of specification.

After you have generated a dataset of your single point as described in the procedure above follow the steps below:

Retrieve the data from the data logger as per the steps in Download. 
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The calibration data should now be displayed in the Plot view. In the Properties view, go 
to Analysis tab > Calibration tab.
Select the Tu sensor type from the drop-down list.  
The Number of Samples field is automatically set to 100. 
This value is the number of sample points Ruskin will average to calculate the calibration coefficients 
for the sensor. Typically, this value should be in the range of 50 to 100 samples.
Click on a stable point in the Plot view corresponding to 0 NTU. In the table in the first row, under Real 
Avg, enter 0 and press enter. 
Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.
Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the data 
logger.
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14.4 RBRcoda T.ODO - User calibration
Ruskin uses a different calibration method for the RBRcoda T.ODO User calibration than the other DO sensors. This 
document outlines the process to complete a calibration using the plot window method.
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14.4.1 Collecting a calibration file
Please refer to the User Guide section 14 (http://files.rbr-global.com/upload/files/
Ruskin_User_Guide_Standard_loggers_.pdf) for information on collecting data for the dissolved oxygen saturation of 
0% and 100%. This method can be used to do a one-point or two-point calibration. The 100% point, or a reference value 
as close as possible to 100%, is our recommendation for the one-point calibration.

When doing a second point at 0% using sodium sulphite we recommend rinsing the sensor immediately after and then 
leaving it in a saturated bath until it reaches a plateau. This will reduce the possibility of residual being left under the 
foil and keep the solution from affecting the sensor's next samples. 

14.4.2 Performing a calibration
Performing a calibration requires that a calibration region be defined which contains a set of plateau markers. See Crea
ting a calibration region and Plateau detection sections for information on how to generate these items. Once this 
has been complete, reference data must be entered. See the Reference data entry section for details on how to enter 
in reference data. The data for the calibration is summarized on the Cursor tab on the Analysis page. 

Ruskin will automatically calculate new coefficients each time data is altered whether it be an alteration of the plateau 
location or changes to reference data.

If there are residuals that are highlighted in red it may mean that a plateau marker is not seated correctly on the actual 
data of the plateau. Each plateau can be moved into the correct position by clicking on the marker and dragging the 
mouse left or right.

http://files.rbr-global.com/upload/files/Ruskin_User_Guide_Standard_loggers_.pdf
http://files.rbr-global.com/upload/files/Ruskin_User_Guide_Standard_loggers_.pdf
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The Save button will be enabled, and the calibration will be completed once all of the plateau residuals are valid, 
indicated by being highlighted in green colour. Saving the calibration performs two operations; stores the newly 
generated coefficients into the RSK file and recalculates the data and stores the new coefficients into a connected 
instrument with the same serial number. The connected instrument must be stopped to update the coefficients.

14.4.3 Creating a calibration region
Open a dataset containing the calibration data
From the plot toolbar select the annotation creation button. Select the Calibration option from the 
dropdown menu.

Move the mouse pointer to the first data point, hold down the left mouse button, and move the 
pointer to the last data point, then release the mouse button. 
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A calibration annotation will now be created and selected, displaying the information bubble.

Filling in the title and details fields are not necessary; however, they may come in handy if there are 
multiple calibration regions in the same file.
From the Channel selection widget, select the channel for which you want to calibrate. Channels are 
labelled by both name and index.

Click the checkmark in the top right of the bubble to save the changes.

14.4.4 Plateau creation

Automatic

Click the Detect plateaus button in the annotation toolbar.
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If there are existing plateaus, a warning dialogue will pop up, indicating that all existing plateau 
markers will be removed. Click 'Proceed' to continue.

All detected plateaus will be visible as grey markers under the calibration region marker

Plateaus that should not be used can be deleted. See Plateau deletion

Manual

Click the Create a plateau button in the annotation toolbar.
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A single plateau marker will be added to the start of the calibration region.

Clicking the Create plateau button a second time will create a new plateau marker to the right of any 
existing plateaus.

14.4.5 Plateau deletion 
Click on a plateau. The information bubble will appear, and the marker will highlight.

Click the trash can icon
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3. Click Delete on the confirmation dialogue

14.4.6 Reference data entry
Reference data can be entered either manually or automatically. The manual process requires that the operator 
enters a reference value for each plateau. The automatic functionally allows the operator to upload a CSV file 
containing the reference data. By default, the calibration is set to Manual entry mode.

The reference can be edited in units of % or μmol/l by selecting the preferred unit in the drop-down menu.

Automatic
The CSV file for the automatic data entry must have two columns; time (in ISO 8601 format), and data (in float/double 
format). For example:
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Once the file has been selected, a dialogue box will appear asking for you to define the column which contains the time 
and which one contains the reference data:

  

Manual

Click the Manual option.
Click the Reference cell on the plateau to be edited.
Enter in a value and click the Enter/Return key on the keyboard.

Complete these previous steps for all points in the calibration

Time

The time in the CSV file will need to be a value that falls within the region of the plateau, however, the CSV file 
can hold additional rows with times that are outside of the plateau region.


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Saving coefficients
If the residuals are within an acceptable range (highlighted in green) the save button will appear in the Calculated 
coefficients section:

When the Save button is selected Ruskin will try to write the coefficients to the instrument if it is connected:

If it is successful it will display Writing to instrument...Complete 

 

If it is not successful it will display Warning: Unable to find Instrument RBRconcerto #######

Annotation - Reference entry

Alternatively, the reference value can be entered on the annotation for the plateau:

       


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15 Preferences
Ruskin sets global preferences that require no changes in many situations. However, as you learn more about what 
Ruskin can do, you may want to change some of these defaults to better suit your requirements. The global preferences 
include:

Where to store output files
Plotting preferences
Configuring derived channels
Calculating derived channels when sensors are missing

You can change these preferences at any time.

15.1 Specify location for data files
You can control where data files are stored by default. Specify these locations before downloading any data.

Steps

From the Options menu, click Preferences.
In the list on the left side, click General.
In File location, type a directory name in the Directory for RSK files text box, or click Browse to 
locate the directory where you want to store data files. 
Click Apply or OK.

You can change where future data files are stored by default at any time. The change takes effect immediately.

15.2 Specify location for realtime data files
You can control where realtime files are stored by default. Specify these locations before connecting any instrument.

Steps

From the Options menu, click Preferences.
In the list on the left side, click General.
In File location, type a directory name in the Directory for realtime RSK files text box, or click 
Browse to locate the directory where you want to store data files. 
Click Apply or OK.

You can change where future data files are stored by default at any time. The change takes effect immediately.

15.3 Specify location for log files
You can control where log files are stored by default. Specify these locations before downloading any data.

Steps

From the Options menu, click Preferences.
In the list on the left side, click General.

Realtime files are generated when a connected instrument is streaming or when the user enables fetching 
mode on the instrument.


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In File location, type a directory name in the Directory for log files text box, or click Browse to locate 
the directory where you want to store log files. 

Click Apply or Close.

You can change where future log files are stored by default at any time. The change takes effect immediately.

15.4 Specify Language selection
Steps

From the Options menu, click Preferences.
In the list on the left side, click General.
In Language selection, select a language from the list. 
Click Apply or OK.

15.5 Using advanced sampling controls
 Steps

From the Options menu, click Preferences.
In the list on the left side, click General.
In Sampling control, select Enable advanced sampling controls check box to change from the 
simple control.
Click Apply or OK.

15.6 Using advanced calibration controls
 Steps

From the Options menu, click Preferences.
In the list on the left side, click General.
In Calibration control, select Enable advanced calibration controls check box to change from the 
simple control.
Click Apply or OK.

The Preferences dialogue box is shown below:

Log files are used when you request RBR support.

Simple control: provides a default list of fixed values.

Advanced control: provides the user the ability to enter any values.


Simple control: provides the user the ability to view and edit the main coefficients (C) for any channel.

Advanced control: provides the user the ability to view and edit all main and dependency calibration 
coefficients (C,X) for all channels.


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15.7 Derived channels RBRsolo/duet

The RBRsolo3 D and RBRduet3 T.D measure pressure and from that sea pressure and depth is derived. The RBRsolo3 DO 
measures percent dissolved oxygen saturation and from that dissolved oxygen concentration may be derived.  

15.7.1 Depth channel
To set up the initial values to derive depth and sea pressure select the menu item Options, then select 
Preferences, then select Derived channels and select the Depth tab. Enable the depth channel and select the 
appropriate calculation methods and edit the default parameters.

Ruskin calculates all the possible derived channels for that specific logger.
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Enter the average expected Atmospheric pressure and the expected density of the water (default values are populated). 
There are two methods to calculate depth - select the appropriate method using the radio buttons. Sea Pressure is 
calculated by subtracting the Atmospheric pressure.  

15.7.2 Dissolved Oxygen concentration 
To set up the initial values to derive dissolved oxygen concentration select the menu item Options, then 
select Preferences, then select Derived channels and select the Dissolved 02 tab. Enable the Dissolved Oxygen 
channel and select the desired concentration units (µMol/L, mg/L or mL/L) from the drop down list.

15.8 Specifying plotting preferences
You can specify how you want the graphical display in the Plot view to behave by default. With the exception of 
choosing colours for each channel, these preferences can be overridden for a particular graphical display in the Plot
view. 

For downloaded files, use the dataset Parameters tab to edit the parameters to derive the channel.

For downloaded files, use the dataset Parameters tab to edit the parameters to derive the channel.

http://docs.rbr-global.com/display/RSKDOC/.Channels+v5
http://docs.rbr-global.com/display/RSKDOC/.Channels+v5
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15.8.1 Channel visibility tab
The Channel visibility tab displays many options to hide or show specific information in the Plot view. These settings 
are applied when displaying a dataset in the Plot view. Some information in this tab is enabled by default. When you 
select any of the checkboxes in this tab, the action is immediate. 

Channel visibility tab with default settings

Steps

From the Options menu, click Preferences. 
In the list on the left side, click Plotting. 
On the Channel visibility tab, select the checkbox for the information you want hidden.  
Events appear at the x-axis as a vertical grey line with a brief text to indicate the type of event, such as 
STP for a stop event in a dataset.
To hide all measured channels, select By default, hide all measured channels checkbox. 
To hide all derived channels, select By default, hide all derived channels checkbox. 
To show information, clear the checkbox beside the information you want to be shown. 

You can click Apply to save your changes without closing the dialogue box.
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15.8.2 Channel colours tab
The Channel colours tab allows you to choose a different colour for each channel that is shown for information 
currently running in Plot view, or from an opened dataset. If there is no colour available that you like, you can create 
your own colour. When you select a colour, the new colour is immediately updated by Ruskin. 

Channel colours tab with the Colour dialogue box to customize a colour for a channel

Steps

From the Options menu, click Preferences.
In the list on the left side, click Plotting.
Click the Channel colours tab. 
In the channels listed, click the channel you want to change the colour for. 
Click the colour box that appears beside the channel list. 
With the colour dialogue box open, select a colour from the Basic colour area. 
Select OK to apply the colour to the channel. 
To create a custom colour: 

Repeat steps 4 and 5.
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Click Define Custom Colours and then choose a colour. 
Click Add to Custom Colours to add the new colour to Custom colours.
Click OK to apply the new custom colour to the channel. 
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